ACCREDITATION PROCESS
INSTRUCTIONS AND REQUIRED DOCUMENTATION

Revised February 2006; March 2008; December 2009; February 2010; October 2010; May 2011; February 2012; June 2012;
September 2012; May 2013; July 2013; March, 2014; August 2016; August 2017

Updated August 2016

1

TABLE OF CONTENTS
Introduction
About ABSNC History
Accreditation Standards
When is an Organization Ready to Submit Initial Application
Submission of a Letter of Intent
Application Process
General Instructions
Instructions for Submitting Application on USB Drive
Additional Helpful Information
Instructions for Required Bookmarking/ Hyperlinking
Accreditation Period
Recognition of Accreditation
Appeal of Accreditation Decisions
Fees
Accreditation of Jointly Owned Certification Programs
Checklist for Submission of Accreditation Application
Application for ABSNC Accreditation Cover Sheet

Updated August 2016

3
3
4
4
4
4
5
6
7
9
14
14
15
15
15
17
18

2

INTRODUCTION
The Accreditation Board for Specialty Nursing Certification (ABSNC), formerly known as the ABNS
Accreditation Council, defines certification as the formal recognition of the specialized knowledge, skills,
and experience demonstrated by the achievement of standards identified by a nursing specialty to
promote optimal health outcomes. The ultimate goal of professional certification is to assist consumers
in making informed choices regarding their healthcare practitioners. To that end, ABSNC provides an
accreditation process for specialty nursing certification programs. ABSNC accreditation signifies
compliance with rigorous standards for certification programs and is a further testament to the public
of the high quality and credibility of an individual nurse’s certification credential.
About ABSNC History
ABNS was incorporated in 1991 after a number of years of discussion and consensus building within the
nursing profession. The Macy Foundation generously supported the process. Consensus building
discussions resulted in the development of 12 standards for nursing certification programs. In 1996,
ABNS formed a task force to review and strengthen the original standards. In addition, a rationale
section was added to each standard. By consensus among members at the ABNS Assembly, 17 revised
standards developed by the task force were adopted. In 1999, the ABNS Assembly revised the standard
to delete the previous requirement for the BSN degree as an eligibility criterion for examination
candidates. Soon afterward, ABNS restructured to create a membership organization with an
autonomous accrediting body called the Accreditation Council.
In 2002, the ABNS Accreditation Council’s total revision of the standards was completed and approved
with the addition of two standards related to continued compliance and quality improvement. In 2003,
after further review of the standards, the standard on continued compliance was eliminated and 18
standards remained. In 2004, the standards were reordered; in addition, Standard 5 (Public
Representation) was revised to require the public member to have voting privileges. Another in-depth
review of the standards was completed in 2010 and revisions approved in March 2011. Substantive
changes to the standards included changes to Standard 5 regarding eligibility criteria/qualifications of
Public Members; Standards 6 and 11 regarding requirements for certifying organizations offering
practice exams; and Standard 17 regarding federal registration of an organization’s certification marks.
In 2007, ABNS began a process for creating a separate, autonomous body to perform the accreditation
function. In 2009, the ABNS Accreditation Council was renamed the Accreditation Board for Specialty
Nursing Certification (ABSNC) and a separate corporation was established.
ABNS members and non-members may seek accreditation of a certification program for RNs, advanced
practice nurses, APRNs, and non-RN members of the nursing team.
In addition, only organizations with at least one accredited certification program are members of
ABSNC, and thus eligible to vote in elections for ABSNC board members and approve amendments to
ABSNC Bylaws.
Members of the ABSNC Board of Directors are elected and represent organizations with at least one
accredited certification program.
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The following information and documents are posted on the ABNS/ABSNC website at
www.nursingcertification.org under the Accreditation Tab and may be downloaded:
• List of approved programs
• ABSNC Accreditation Standards
• Instructions for Submitting Accreditation Application
• Fees
• Policy and Procedure Manual
• Bylaws
• FAQs
Accreditation Standards
ABSNC accreditation is based on documentation that demonstrates a nursing certification program
meets all standards of ABSNC. A standard is defined as “an authoritative principle or rule that provides
a model or pattern of guidance.” Each standard is followed by a rationale that provides a full
explanation of the meaning of the standard and its importance to ABSNC. The criteria that follow each
rationale can be considered the basis for making judgments about the certification program's ability to
meet the standard. Required documentation is listed for each standard. Reviewers will determine if an
application meets the criteria based on the documentation provided. To be eligible for accreditation,
certifying organizations must provide the requested evidence (e.g., policy and procedure, description/
narrative) that each criterion is met. Compliance with all standards must be demonstrated for initial
accreditation and reaccreditation to be granted.
Initial accreditation applications must demonstrate compliance with the most current Accreditation
Standards as posted under the Accreditation tab of the ABNS/ABSNC web site. The Accreditation
Standards available on the web site always indicate the dates of the most recent revision and update.
Because the time required to prepare an accreditation application can be lengthy, organizations are
advised to check the web site regularly to ensure they are using the most current version of the
Accreditation Standards.
When is an Organization Ready to Submit an Initial Accreditation Application?
In addition to being able to submit documentation of compliance with each standard, a certifying
organization must have examination statistics data to report for at least 1 year of testing or for a
minimum of 200 candidates, whichever occurs first.
SUBMISSION OF A LETTER OF INTENT
An organization seeking initial accreditation from ABSNC must submit an electronic Letter of Intent to
Submit 3 months before application submission to the ABSNC office at info@absnc.com.
APPLICATION PROCESS
All application materials will be treated confidentially. Applicant information is shared among ABSNC
board members and volunteer psychometricians only. No reviewer may disclose or release information
contained in an application. After an application review is completed, one copy of the application will
be retained by ABSNC. Notes in the possession of individual reviewers are destroyed. Application USB
drives will be returned if requested but otherwise are destroyed in a secure manner.
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The application process is designed to allow the applicant organization to demonstrate a certification
program meets each ABSNC Standard. Completion of the application is similar to a self-study in which
the applicant organization assesses the certification program and provides evidence of compliance with
the ABSNC Standards.
The applicant organization may be contacted for additional information or clarification. If ABSNC
reviewers need to request additional information more than three times, the applicant organization must
resubmit the application and pay application fees again.
Applications for initial accreditation may be submitted at any time during the year. Each application will
be evaluated individually by an ABSNC Review Team. Every effort is made to complete the application
review and determination of accreditation status within 60 business days after receipt of an application.
If a federally recognized holiday occurs during this period, the review time is extended. If additional
materials are requested of the applicant organization, the review/approval time may be increased.
Each Review Team makes a final accreditation recommendation to the ABSNC Board of Directors.
Approval from two-thirds of ABSNC Board of Directors is required for accreditation approval.
In order to submit an accreditation application for a certification program for non-RN members of the
nursing team, the certifying organization must have an RN and/or APRN certification program currently
accredited by ABSNC.
GENERAL INSTRUCTIONS
Please note: Paper applications are not accepted. Accreditation applications must be submitted
electronically on two USB drives as described below.
The applicant organization is responsible for all expenses related to shipping of the ABSNC accreditation
application on USB drives to the ABSNC office, and to the applicant organization if return is requested. A
prepaid shipping label must be provided for returned USB drives.
The electronic application must be submitted to the ABSNC office as noted below. Notify the ABSNC
office prior to sending an application and use a carrier with tracking capabilities such as the USPS or
FedEx. Please contact Felicia Lembesis, ABSNC Executive Director, with any questions
(info@absnc.com). A follow-up telephone call will be scheduled if desired. Send the accreditation
application USB drives to:
ABSNC
1120 Rte 73 S, Ste 200
Mt Laurel, NJ
08054
856-439-9080
A non-refundable application fee and application cover sheet (found on the last page of this document)
must accompany each application, as described under the Fees section of this document. A check
should be made payable to ABSNC.
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Download the standards document from the website (www.nursingcertification.org - "Accreditation" )
as a Word document so that it may be used as described below.
Instructions for Submitting Accreditation Application on a USB Drive
All information and documents must be submitted as a single, bookmarked PDF file. Additionally,
hyperlinks must be added to assist reviewers in locating specific referenced information in the
application. These features allow ABSNC reviewers to find the submitted evidence easily and evaluate
compliance with each standard. Of note, a potential problem with using only hyperlinks is that the
reviewer is not able to return easily to the narrative document. Specific exhibits and page numbers
should be referenced, even when hyperlinks are added. When bookmarking and/or hyperlinking, use
a different color of type to denote the bookmark link and/or hyperlink.
Instructions for creating a single, bookmarked PDF file and adding hyperlinks are included in the
“Instructions for Bookmarking & Hyperlinking an Accreditation Application” section of this document.
The services of an outside resource (e.g., Office Depot, Staples, independent contractor) can be used to
create files. ABSNC neither endorses nor recommends any particular resource or vendor. In addition,
staff of the applicant organization should ask their vendors, related membership society, or publishers to
provide a PDF version of required documents and publications (e.g., training materials, Core Curriculum).
The following instructions are provided to assist nursing certifying boards in developing and organizing
the electronic application.
Procedure
1.

Thoroughly read the "Instructions for Submitting an Accreditation Application."

2.

Read the entire ABSNC Accreditation Standards document to determine the type and scope of
information that must be provided to demonstrate compliance with each of the standards.

3.

Organize information according to the instructions. Each section of the application must be
bookmarked within the final, combined PDF and labeled as follows.
a.
Narrative Section
(1)
Overview of certification organization and its certification program(s)
(2)
Standard 1 (For each standard, in the Narrative column, cite the Tab or
Appendix for specific supportive documentation [evidence] and hyperlink
directly to the relevant document.)
(3)
Standard 2, etc.
b.

Appendices Section – includes publications/documents referenced often throughout
the application:
(1)
Appendix A – Standards of Practice for Specialty
(2)
Appendix B - Certification Handbook
(3)
Appendix C - Recertification Handbook
(4)
Appendix D - Bylaws
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(5)
(6)
(7)
(8)
(9)
(10)
c.

Appendix E - Policy and Procedure Manual
Appendix F - Testing Vendor’s Policies & Procedures specific to the applicant
organization
Appendix G - Item Writers' Training Manual
Appendix H - Certification Organization’s Annual Report from Testing
Vendor
Appendix I - Testing Vendor’s Chief Examiner’s Training Manual
Appendix J - Testing Vendor’s Manual for the Administration of Applicant
Organization’s Examination(s)

Tabs Section – includes documentation to demonstrate compliance with a specific
aspect of a standard; for example:
(1)
(2)
(3)

Tab 1 - Table of Contents from Core Curriculum
Tab 2 - Examples of information describing educational programs focused on
specialty
Tab 3 – Job description

4.

Include a Table of Contents in each of the three sections, listing the exhibit title and document
name. For example, Appendix A – Name of document; Tab 20 – Name of document.

5.

Any information available in hard copy only must be scanned and saved as a PDF document.
Place this PDF document in the appropriate location within the final PDF file.

6.

The final bookmarked PDF that contains all the combined PDF files (Narrative section with the
organizational Overview, and each Standard and narrative; Appendices; and Tabs) must be
copied to two separate USB drives. Label each with the certifying organization’s name. For
example, ABNPR. In addition, make two paper copies of the Application for ABSNC Accreditation
Cover Sheet (the last sheet of this document) to include in the mailing along with the fee.

7.

The USB drives with the application will not be returned to the submitting organization unless
requested. To have USB drives returned, please provide prepaid mailing materials (e.g.,
envelopes with return address and postage affixed, or completed FedEx or UPS shipping forms
with organizational account number). If no instructions are provided, the ABSNC office will
destroy one USB drive using a secure method. ABSNC retains one USB drive for its records.

ADDITIONAL HELPFUL INFORMATION
•

The application and all supporting documentation must be organized in three sections within
the final bookmarked PDF: one section for Narrative, one section for Appendices, and one
section for Tabs. Each section should include a Table of Contents specific to that section. This
will facilitate review of submitted electronic materials. Each location referenced within your
application must be bookmarked in the corresponding Appendix or Tab. When referencing a
specific document or document location in the Appendices and/or Tabs sections, hyperlink to
the bookmark directly to the document.
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Lengthy documents, such as candidate handbooks and policy manuals, should include
bookmarks for each section of the document.
When the narrative references a document found in the Appendices or Tabs section, please
specify the appropriate page number within the referenced document and bookmark that
page. This is critical to the team’s expedient, thorough review.
•

The Narrative section contains a brief overview of the applicant organization and the current
ABSNC Standards document, which contains a completed description of how the organization
meets standard criteria.
Overview
Before the Narrative portion of the standard is begun, a brief overview of the organization
should be provided. The purpose of this overview is to give the reviewer an introduction to the
organization that will make reading of the narrative more understandable.
The overview should include, but is not limited to a description of the certification program
being submitted and the related certification credential, what the certification credential
acronym means, the number of certified individuals at the time of the application, the length of
the certification period, a summary of options for recertification, a list of the testing and/or
management company that provides service (including the name, address,
names/credentials of staff assigned, and names/credentials of certification staff, if applicable),
brief description of governance structure (e.g., A nine member Board of Directors comprised of
eight RNs and one Public Member, governs XX organization), and a brief summary of the
certifying organization’s history.
Standards
The ABSNC Standards document should be saved as a Word document; it is designed so the
applicant can type into the column called Narrative. This column should indicate where to find
supporting documentation that demonstrates compliance with the specific element of a
standard (i.e., reference a specific Tab or Appendix, and bookmark and hyperlink to the specific
section and page number within the exhibit). For example, the list of item writers and their
demographics might be found in Tab X while the “Review and Appeal” policy would be found in
Appendix X, Section Z, page Y. Unless otherwise noted, the Narrative column should indicate
simply, “See Policy xyz, found in Appendix X.” In the final bookmarked PDF, each exhibit will be
bookmarked with hyperlinks provided to the specific document location.

•

•

The Appendices section contains documents continually referenced throughout the application.
For example, this section would include the organization’s complete Policy and Procedure
Manual, Bylaws, Candidate Handbook, Recertification Handbook, testing vendor’s Proctor
Manual, Item Writer’s Manual, etc. If the Narrative refers to a portion or section of a particular
appendix or tab, each relevant portion or section of the appendix or tab should be bookmarked;
hyperlinks also must be added from the reference in the application to the appropriate
document.
The Tabs section contains all other supporting documents. If the Narrative refers to a specific
tab that may have multiple pages, the appropriate page number should be identified within the
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tab with bookmarking of the corresponding page. Hyperlinking from the reference in
the application to the supporting document will ensure reviewers can locate the
appropriate evidence.

INSTRUCTIONS FOR REQUIRED BOOKMARKING/HYPERLINKING
ABSNC requires all applications to be submitted in a single bookmarked PDF file with hyperlinks to
referenced documents within the application. When bookmarking and hyperlinking, use a different
color of type to denote the bookmark link or hyperlink.
Adobe Acrobat must be installed to bookmark and hyperlink an application using these directions.
These instructions are based on Adobe Acrobat X, but should apply to other versions as well. Adobe
Reader cannot be used to create bookmarked files.
Step 1: Initial Document Preparation
Adding page numbers should be considered when creating an Appendix or Tab that does not have
them. This will make it easier to refer reviewers to a specific location within the document. Page
numbers also can be added to a PDF by using the header feature.
Files should be reviewed, edited, and finalized before converting them to PDF. Making editorial
changes in Word is easy, but the process becomes difficult and much more time consuming once files
are in PDF format.
Step 2: Creating Bookmarks
The completed application should be converted to an Adobe PDF file. Each Appendix and Tab also must
be converted to PDF format. Naming each file with the corresponding exhibit name will save time
when combining files later in the process. For example, if Appendix A is the Scope of Practice, the file
name should be changed to “Appendix A – Scope of Practice.” Once this process is complete, the files
may be bookmarked in Adobe.
Each file may be bookmarked and then combined into one PDF or all the files into one PDF and then
insert the bookmarks. Instructions in this document assume bookmarks are created first.
The application form and each Appendix and Tab more than a few pages in length should be
bookmarked. Adding bookmarks creates an electronic table of contents that allows reviewers to
navigate the application and exhibit materials easily.
The completed PDF files should be opened to begin inserting bookmarks.
•

Before bookmarking, set the document to open the bookmark panel automatically by following
these steps: (1) Go to “File > Properties” and click on the “Initial View” tab. (2) Under “Layout
and Magnification,” find the “Navigation tab” option. (3) Select “Bookmarks Panel and Page,”
then click “OK.”
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•

After this is complete, go to the first page you want to bookmark.

•

To view the bookmark panel, click the bookmark icon on the left of the screen.

•

Insert a bookmark by clicking the bookmark icon at the top of the bookmark panel. In the
bookmark panel, a bookmark pops up with “Untitled.” Type in the title for the first bookmark
(e.g., “Standard 1”) and hit "enter." This will create a bookmark linked to the page that was
on screen.

If you need to reset the destination for a bookmark after it has been created, navigate to the
proper location in your document, right click on the bookmark, and select “Set Destination.”

Updated August 2016

10

•

You also need to move bookmarks to a multilevel view, especially for Appendices that are
bookmarked within the document. To do this, click on the bookmark you want to move and
drag it up or down to place it appropriately in the bookmark panel.

The application form and each Appendix and Tab more than a few pages in length should be
bookmarked.
Shortcut: Instead of typing the name of each bookmark, use your cursor to highlight text on
the page that will match the title of the bookmark. For example, if you are creating a
bookmark titled “Content Outline” and the heading on the corresponding page is “Content
Outline,” you may be able to highlight the words “Content Outline” with your cursor (using
the selection tool – see screen shot below) and then click the bookmark icon in the bookmark
panel. This may save you a lot of typing. However, it will NOT work in some documents that
have been scanned as an image.
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Step 3: Hyperlinking
Follow this step when organizing the application with hyperlinking.
Before converting the accreditation application to PDF format, use a different font color and format
for the text that will eventually by hyperlinked in the application. For example, blue underlined text
works well to indicate a hyperlink and will make it easy to locate the text for links later in the process.

The Candidate Handbook lists the content outline for the ABC Certification
Examination developed as a result of the job analysis.
Appendix B, Candidate Handbook, Content Outline, pages 12-25
Step 4: Combining PDF Files
After all PDF files have been finalized and bookmarked, they must be combined into one PDF file. Two
methods can be used to combine multiple PDF files into one PDF document.
1) Combine PDFs in Windows: (1) Open a documents window. (2) Open the folder where the PDF
files are saved. (3) Highlight the files that should be combined. (4) Right click on the
highlighted files and select “Combine Supported Files in Acrobat…”
Using this method will result in bookmarks automatically being created to correspond with
each file name.

2) Combine PDFs in Adobe: (1) Open Adobe and select “Combine Files into PDF” from the start
screen or from the “Create” drop down menu. (2) Select and click “Add Files…” in the
"Combine Files" window.
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Once files have been added, they can be moved up or down as needed to place them in the
order in which they should appear in the final combined PDF. When files have been placed in
the correct order, click “Combine Files.”
Additional files can be added later by using "Tools" > "Insert from File."
Step 5: Adding Hyperlinks
To begin the hyperlinking process, click on “Tools > Content > Link” (or use the chain link icon on
the top tool panel).

Scroll down to the first standard (or location where the link should be placed). Move the cursor over
the first reference to hyperlink and highlight it using the cursor. A box will appear. Under "Link
Appearance," be sure the link type is “Invisible Rectangle.” Under "Link Action," be sure the radio
button “Go to a page view” is selected. Hit “Next.”
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Another box will appear. Drag this to the side or out of the way for just a moment (if needed). DO NOT
CANCEL IT!

Now, click on the bookmark to which you you want to hyperlink the text and then scroll to the specific
section referenced (e.g., Appendix B, Candidate Handbook, Introduction, pages 2-3). Once that section is
on the screen, return to the “Create Go to View” box and click “Set Link.” The hyperlink has been created.
Continue through the entire application and hyperlink all text you formatted for hyperlinking. Adobe
should link all web pages automatically. If it misses one, follow the same steps as above with the
following exception: Under "Link Action," be sure the radio button says “Open a web page.” Hit "OK" and
another box will appear, indicating “Enter a URL for this link.” Type in the website and click “OK.” The
link is set.
ACCREDITATION PERIOD
ABSNC accreditation is granted for a period of 5 years, beginning with the date of approval. Providing no
major changes have been made to the accredited certification program, accreditation must be renewed
annually by submitting the Annual Compliance Report and paying appropriate fees. Annual reports must
be submitted to ABSNC to confirm continuing compliance with Standards.
Organizations must seek reaccreditation every 5 years. A renewal notice is sent to accredited
organizations 24, 15, and 12 months before the accreditation expiration date. Applications must be
submitted no later than 6 months before the expiration date to allow time for review before
accreditation expires. Expiration occurs on the first of the month.
RECOGNITION OF ACCREDITATION
ABSNC recognizes accreditation of an organization’s certification program by providing a framed
certificate and recognizing the organization at an ABNS Assembly meeting. The name of the organization
and all accredited certification programs also are listed on the "About ABSNC" section of the ABNS web
site (www.nursingcertification.org).
Organizations with accredited examination programs are encouraged to communicate this achievement
by using the phrase, “The XYZ certification program is accredited by the Accreditation Board for Specialty
Nursing Certification” on publications and other communication vehicles such as the web site. ABSNC will
email organizations the ABSNC logo art for use in publications, if requested.
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APPEAL OF ACCREDITATION DECISIONS
In instances in which accreditation is not awarded, the applicant organization will be given specific
reasons for the denial of accreditation. A copy of the ABSNC “Reconsideration and Appeal of
Accreditation Decision” policy and procedure will accompany notice of denial of accreditation or
reaccreditation.
FEES
Application Fee
A non-refundable application fee (check payable to "ABSNC") must be submitted with the application
and cover sheet. Applications submitted without the application fee will not be processed until the
application fee is received. ABNS Regular Member organizations benefit from reduced accreditation
application fees. The application fee for non-members is $1000 per certification program submitted.
The fee for ABNS members is $750 for 1 – 2 certification programs, and $1000 for 3 – 5 certification
programs.
Multiple certification programs must be submitted at the same time to obtain the reduced fees.
Shipping Fees
A prepaid shipping label should be included with the application if the applicant wants one of the USB
drives to be returned.
Annual Renewal Fees
Upon notification of approval of initial accreditation, the applicant organization will pay annual
accreditation fees within 60 days of receipt of notification of approval. These fees are prorated based
on the quarter in which the application is approved. An invoice will be sent to the organization by the
ABSNC office.
Annual renewal fees are based on a formula using candidate numbers as of June 30 each year. The fees
are $0.35 each for the first 25,000 certificants and $0.15 for each certificant over 25,000. The
accreditation fees are capped at $15,000 per year. Annual renewal fees are due to ABSNC by July 1 of
each year. Fees for an organization’s first accreditation are prorated depending on the time of year an
application is submitted.
For organizations submitting an application for reaccreditation, fees are paid annually as noted on the
annual invoice sent by the ABSNC office.
ACCREDITATION OF JOINTLY OWNED CERTIFICATION PROGRAMS
ABSNC accepts applications for accreditation of certification programs jointly owned by more than one
nursing certification organization. In the case of jointly owned certification programs:
(1)

ALL accreditation standards apply to all owners.
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(2)
(3)
(4)

ALL policies and procedures adopted for the management of the program must be adopted and
implemented by all owners.
ALL owners must submit copies of policies and procedures that govern their individual functions
as requested in the standards (e.g., public member; autonomy from the member organization in
terms of governance, finance and certification program management).
A copy of the agreement between owners must be provided as part of the accreditation
application. Information related to financial impact may be redacted if desired by the
organization.
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Checklist for Submission of Accreditation Application
Have you:
 confirmed you have used the most current Accreditation Standards found on the
ABNS/ABSNC website (www.nursingcertification.org > "About ABSNC")?
 prepared and labeled two USB drives, each containing a complete application that includes a
PDF of the application and all materials to demonstrate compliance with the ABSNC Standards?
 organized the final bookmarked PDF application document into three sections: Narrative, Tabs,
Appendices?
 included a table of contents for each of the three sections that includes a list of the documents
in each section?
 confirmed (1) the application and each tab and appendix is bookmarked in the final PDF file, (2)
each tab and appendix coincides correctly with the narrative to which it refers, including page
numbers, and (3) references in the application are hyperlinked to the correct document?
 enclosed a check payable to "ABSNC" for the appropriate application fee?
 completed the Application Cover Sheet found on the last page of this document and enclosed
two copies, one for each of the USB drives?
 included your organization’s prepaid shipping label if you wish to have one USB drive returned
after review is complete?
 notified the ABSNC office you are submitting your accreditation application prior to shipping?
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Application for ABSNC Accreditation
Cover Sheet
Please check one:

Initial Accreditation

Re-accreditation

1.

Name of Organization:

2.

Street Address:

3.

City:

State:

4.

Telephone:

Fax:

5.

Contact Person:

6.

Address and Telephone Number (if Different from Above):

7.

Email Address:

8.

Title of Certification Program(s) Submitted for Accreditation

9.

Credential(s) Awarded:

10.

Date Application Submitted:

Zip

Title:

For office use only
Date acknowledged:
Date received:
st
Date RT notifies staff of 1 review outcome:
Date sent to Review Team:
st
st
Date
1
additional
information
rec’d:
Date 1 additional information requested:
nd
nd
Date
2
additional
information
rec’d:
Date 2 additional information requested:
rd
rd
Date 3 additional information rec’d:
Date 3 additional information requested:
Date
staff emails ballot to ABSNC:
Date Review Team notifies staff of approval or denial
Date
organization
notified:
Date approved/not approved by ABSNC:
Press
Release
done:
Website
Update:
Fees received:
Certificate awarded:
(ABSNC Instructions for Submitting Accreditation Application – 5-2013)
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